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Welcome to the DSPControl software for your iD4/iD7
amplifier!

This manual will guide you through the user interface elements and will explain
how to organise, backup and restore your Presets and amplifier settings.

Additionally, it will describe the iD4/iD7 Preset and amplifier protection con-
cept. This can be used for example to efficiently keep your Preset's EQ and
limiting settings safe, or if you simply want to prevent normal User’s from chang-
ing any important amplifier settings they shouldn’t touch.

We assume that you are familiar with basic Pro Audio signal processing
options, so the functionning and available parameters of the rich EQIing, filtering
and limiting settings will not be outlined in detall in this manual. But be assured
that you have purchased a product featuring the latest state-of-the-art DSP
performance with full 96 kHz /24 Bit resolution. Especially the 6-channel muilti-
band-compressor in the output section gives you an outstanding tool to control
and protect your loudspeakers.

Fie Hardware Help

Efficient loudspeaker excursion control and long-term RMS power limiting for
low, mid and high frequency are the key benefits of the powerful limiting sec-
tion, thus allowing you to create tallored Presets with full loudspeaker protection
and at the same time maximum output power performance.




1. DSPControl software installation

This chapter describes the installation of the DSPControl software and updat-
ing of the amplifier's firmware. For instaling the DSPControl software there is
no need to have an amplifier connected. But for updating the firmware on your
iD4/iD7 ampilifier, the units have to be connected via Ethemet of course.

1.1 Installation requirements

The following operating systems are supported:
— Windows XP with Service Pack 2

— Windows 7 or higher

—Mac OS X 10.5.8 or higher

35 DSPControl Setup S

Welcome to the DSPControl Setup
Wizard

The Setup Wizard wilinstall DSPCantrol on your computer.
Click Next to continue or Cancel to exit the Setup Wizard,

1.1.1 Windows

Download the installation package for your Windows version from our website
and open it. The installer will guide you through the installation procedure. It is
not needed to remove any older versions, they will be removed automatically.
You will need administrator privileges for installation.

Depending on the user rights within your operating system, you may also need
to run the program as administrator for proper operation.

eo0o s Install CAMCO DSPControl

Welcome to the CAMCO DSPControl Installer

© Introduction

® License \ You will be guided through the steps necessary to

\ instal this software.
© Destinatiopliele
o Installatigh Typg/

@ Installagion 3

L Go Back Conti
1.1.208 X
Download the installation package for OS X from our website, unpack and
open it.

With OS X 10.7 or higher you might get a message (@) that you can't open the
installer due to the standard security settings under OS X.

\r “CAMCO DS™"  trol.mpkg" can't be \r “CAMCO D* Cont. L.mpkg" is from an
/ # opened becaus: 't is from an unidentified / # unidentifieu devel »er. Are you sure you

@ (=) @ | Open ] [[Cancel]
If you get that message, just rightclick the installer icon and select “Open” from
the context-menu. Then click the “Open’-button of the verification-dialog (@)
and there you go.

The installer will guide you through the installation procedure. During the instal-
lation process you will get asked to enter your system password, so it will be
handy to have it ready. It is not needed to remove any older versions, they will
be removed automatically.
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Set Software Password
New Group

Enter Demo Mode.

Enable Update:
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CAMCO

Firware Update AllUnits

1.2 Demonstration mode

Once installed, the DSPControl software offers a fully functional demonstration
mode, which allows you to explore all features without having to connect an
amplifier. In this mode it is possible to load and save Presets from and to your
computer. The demonstration mode is limited to the User mode access level.
It can be activated from the network panel menu bar “Tools > Enter Demo
Mode”.

1.3 Preset data integrity

Instaling a new version of the DSPControl software will not touch any Presets
stored on your iD4/iD7 or computer.

But we recommend to create a backup of all amplifier Presets and settings in
case you want to update the amplifier frmware.

1.4 Uninstalling the DSPControl software

Windows
To uninstall the CAMCO DSPControl software from your computer, select
“Start > All Programs > CAMCO > Uninstall DSPControl”. Alternatively, you
can run the installation setup again to repair or remove the application.

OS X
Just go to your applications folder (standard) or the folder in which you have
the software installed and remove the DSPControl application by moving it to
the trash.

1.5 New versions / updates
Please visit the downloads section of our website to check for new versions of
the DSPControl software.

= http.//www.camcoaudio.com/download.htm/
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1.6 iD4/iD7 amplifier firmware update

For smooth remote control of your iD4/iD7 amplifier it is important to match
the amplifier's firmware to the current version of the DSPControl application.
If not, incompatibilites can cause problems while performing actions on your
connected amplifier.

So please check if there might be a frmware update available by opening the
“Help » About” menu window in the main amplifier panel.

5 About ==

Uit Information

%78
Firmware Version: 3.6.9 (Update Avaiable)
Interfoce Version: 2.7.0 (Update Avalable)

Appication Information
‘Appication Version: 3.9.2.

Buid: 109216
SW Acceleration: Enabled

Copyright (C) CAMCO

Altermatively, you can also check in the release notes compatibility table on
page 11.

Following are some importants points to know and to respect when performing
a firmware update:

> If the current access level doesn't have the access right to update the ampli-
fier's firmware, you will not be able perform firmware updates.
- See also chapter "Access Right Options” for details.

> Updating the firmware will usually reset all settings (i.e. access rights, pass-
words, Unit name, network settings, power-on Preset, read-only Preset range,
auto-standby and display setting) to factory defaults and all Presets will be
erased.

= To avoid losing your settings and Presets you can either do a manual backup
before the update or use the automatic backup and restore function offered
during the update procedure (when started from the main control panel's menu
par).

> During the update process, ticks and pops may occur, dependig on the
hardware. So please disconnect your loudspeakers to avoid discomfort or
even damage. Make sure that no other units are power cycled during the
update process, this may disturb the process.

> If the update process is interrupted or fails for any reason (even in case your unit
would not start up anymore) you can repeat the process at any time. Switch off
your hardware and close the software, restart your unit and repeat the process.

- To avoid network problems during firmware update, we recommend to use
an automatic (DHCP or link local) configured network without static 1P address
and subnet. Firmware update with static IP address is basically possible, but
can cause network problems during update depending on network topology.

> The update of your iD4/iD7's frmware without the automatic backup and
restoring should be finished in about 1 to 2 minutes (depending on your hard-
ware and connection speed).

Using the feature to automatically backup and restore the amplifier's Presets
should take about 2.5 to 4 minutes, also depending on hardware and con-
nection speed.

1.7 Updating the iD4/iD7 firmware
There are three ways to start the firmware update procedure:

1.7.1 Option @: Via the main control panel’s menu bar

= Preferred upc ption

Open the amplifier's main control panel and select the menu “Unit > Firmware
Update” to start the update.

Starting the firmware update from the amplifier's panel will always carry out an
update, even if the firmware is already up-to-date.

If you perform a firmware-update on your iD4/iD7 amplifier from the main con-
trol panel, the update process has the option to backup and restore the ampli-
fier's Presets and settings automatically in a fast way (availbale since version
v3.9.2 for updates from version v3.7.0. If you were running a version lower than
v3.7.0, fast backup and restore will not be supported. In this case please refer
to the chapter “Presst Notice”).



1.7.2 Option @: Via the network panel’s update button for a specific

amplifier
> Recommended if you we amplifier in c: it is not properly
reco ed in tr not able to open the amplifier's

ma
From the network panel's menu bar you can select “Tools > Enable Update”
to display the update buttons. If the update button is shown orange, the unit's
firmware can be updated, otherwise the button is greyed out (which means the
firmware is already up-to-date or that you don't have the right to do the update).
Simply click on the update button (orange) to start the update on the unit.

1.7.3 Option ©: All at once via the network panel’s menu bar

> Not re mened

By selecting “Tools » Firmware Update All Units" from the network panel's
menu bar, you have the possibility to update the firmware of all connected
iD4/iD7 amplifiers with just one click.

The update will only be carried out in case there is a newer version available.
This method of updating the firmware is still available but not recommended
anymore, because network problems might easily disturb or even interrupt this
procedure. We recommend to use the firmware update option 1 or 2 instead.

By updating the firmware from the network panel with options ® or ©, the
amplifiers will be reset to factory settings and all Presets will be erased.
We recommend to use option @ (if available) for a secure update proce-
dure. Because only this option offers error handling (in case of network
problems or unusual network topology) and automatic Preset backup and
restore options.

1.8 Amplifier backup folder structure

Since CAMCO DSPControl software version 3.9.2 the amplifier backup data
will be saved automatically to your computer for optional data recovery in case
it might be needed. To organize the automatic and manually created binary files
the following folder structure is used:

il [ Storage folder |
L i backup
L i [ Amplifier MAC address |

+ il Auto_Backups
L B *_Auto_Backup_V3_6_9 ffi

+ il Auto_Uploads
L B *_Auto_Upload_V3_11_2 ffi

L i@ Manual_Backups
L B *_Manual_Backup_V3_11_2 ffi

1.8.1 Folder descriptions

Auto_Backups will store the original amplifier configuration before the update
has actually been carried out. But note that the binary file will only be created
and stored if you explicitly choose to create a backup when starting the update
procedure. If you don't, there will be no backup created in this folder either.

Auto_Uploads will store the converted and updated amplifier configuration
which is uploaded back to the amplifier during the update process.

Manual_Backups will store the user created binary backup files.
This is only the recommended default directory. You are of course free to store
your manual backups to any other location on your computer of course.




1.8.2 Filename description
The file names will be structured based on the following scheme:

B8_96_74_01_06_16_2016_01_13_1159_Auto_Backup_V3_6_9.ffi

® Amplifier MAC address
Backup date

® Backup time (at file creation, can differ from the system file creation time)
Backup type (see folder names description)

® Firmware version included in this binary backup

1.8.3 Storage folder
The product application folder (storage directory) will be different depending on
the operating system you use.

Windows
[ SystemDrive ] - Users = [ Username ] - AppData - Roaming - CAMCO - backup

OS X
[ SystemDir | > User - [ Username ] - Library - Preferences - CAMCO - backup

1.9 Manually restoring amplifier settings via “Load Flash Image from File”
Since DSPControl version 3.9.2 and higher, all automatical and manual flash
image backups can also be restored manually with the “Load Flash Image from
File” option in the “File” menu.

But please note that loading a flash image will also “update” the ampilifier firm-
ware to the version originally included in the flash image at the time it was origi-
nally created. So you might encounter firmware incompatibilities with the latest
DSPControl application after having loaded a flash image. But still all Presets
and amplifier settings are kept and transferred, so there is no risk of losing data.
With this feature you could easily downgrade any amplifier to an older configu-
ration if needed or neccesary, or recover a previous setup in case there were
problems during the update procedure.



2. Release notes

This is a list of changes, bugfixes, and known issues since version v3.1.9
related to your DSPControl software and the firmware for your iD4/iD7.

DSPControl v3.9.2 (amplifier frmware v3.11.2

Changes
Possibility of full audio routing
New designed and more detailed update/download progress window
Create binary amplifier configuration backup images which replaces the
Factory Presets and allows to backup the whole amplifier configuration
Corrected the PEQ window curve mathematics
Redesigned firmware up- and download communication for faster configu-
ration data and Preset import/export
Harmonized the Unit menu list entries between the different access levels
Added official support for Windows 8 and Windows 10
Removed fullscreen functionality from amplifier view
New EULA

Fixed issues
Text input boxes had undefined behavior in case of non defined input values
Standard update mechanism showed user message “Please power cycle”
before the data upload was finished
Manual IP address configuration accepted invalid IP ranges
Erase fail during ethermet firmware upload if an arbitrary network device
answered the broadcast progress message generated by DSPControl

DSPControl v3.8.0 (amplifier firmware v3.8.1)

Changes
Enhanced and optimised input source selection
Harmonised Unit menu entries through all access levels
Improved GUI window handling for better response
Improved Windows 8 installation procedure (no driver installation worka-
round needed anymore)
Added amplifier Telnet remote control option

Fixed issues
Input source selection now stored inside Presets
No losing of focus anymore when moving the main amplifier panel window
quickly

DSPControl v3.7.0 (amplifier firmware v3.6.9)

Changes
Support for iD7 amplifiers
Encryption of Presets, backups and Factory Files when storing to com-
puter's hard drive for enhanced security
Option to clear all user or factory Presets in Developer mode

Presets, backups and Factory Files once stored with v3.7.0 (or higher) will
not be readable with any previous versions. But stored files from previous
software versions are fully compatible of course.

DSPControl v3.6.6 (amplifier frmware v3.6.5)

Fixed issues
Compatibility issue with OS X 10.9 Mavericks: When restarting the applica-
tion, previous versions would not reconnect without a restart of the system

* unpublished version




DSPControl v3.6.5 (amplifier firmware v3.6.5

Changes
Simplified Unit and Preset access rights options
Automatic backup and restore of all amplifier settings when doing a firmware
update (optional)
Reorganised menu structure and renamed menu entries
Possibility to erase all Presets in Developer mode

Fixed issues
Improved Preset backup and restore functions; now more robust even with
bad network connection
Several bugfixes and improvements

Due to some changes in the Preset structure it is neccesary to follow a
certain procedure to transfer your old Presets to the latest version.

- Please see chapter "Preset Notice” for a detailed description.

DSPControl v3.5.6*

Changes
GUI (Graphical User Interface) facelift
Dual bargraph scaling in dBu and dBFS for all input bargraphs
All parameters can be accessed and changed again from the amplifier
display (Filters, PEQ’s, Limiters ect.)
BLC limiter improvement
Threshold settings of output BLC now done in Vpeak

Fixed issues
Auto Standby function now working correctly
“Popping sound” at powerup removed

DSPControl v3.5.4*

Changes
Factory files and backups now support locked Presets
Added trim gain for selected models

Fixed issues
Setting Bridge Mode from the DSPControl software

DSPControl v3.4.7*

Changes
Unit panels are restored and brought to front when trying to launch them
while they already exist
Demo password does not need to be entered anymore after entering Demo
mode from the network panel
When creating Factory Files, the supported units can be selected

Fixed issues
Creating Factory Files did not work in version v3.3.X to v3.4.0
Added “0” to choices of read-only Preset range
Restored “Invalid Password” error dialog when entering an invalid password
(this includes the Preset passwords)
Removed low-level compressor distortion (audible in LF channels)

* unpublished version



DSPControl v3.3.8*

Changes
Major performance improvements on all operating systems, especially when
using more than 10 connected units with a Windows PC
Major sound quality performance improvement on AES input
Added “Firmware Update All Units” under “Tools”. This process simultane-
ously updates all connected units and can take several minutes.
Mutes can be controlled even if a channel is locked
In Developer mode, the number of factory Presets (write-protected Presets)
can be set
Units can be renamed in the network panel
Groups and units are alphabetically ordered in the network panel
When loading a Preset from computer, the progress dialog closes automatically
Units are no longer indicated to be muted while they are in standby
Clicking the icon of the minimized program in the dock in OS X restores the
windows

Fixed issues
Group power button
Group mute
Slope indication in PEQ Q text box corrected when changing between Bell
and Shelf filters
Group rename
Many smaller bug fixes

DSPControl v3.2.1*

Changes
Faster update of PC interface when changing values via front panel
Possibility to set end user access rights per Preset

DSPControl v3.2.0*

Fixed issues
Log in via ampilifier display
Preset save/reload issue

2.1 Compatibility table of DSPControl software and iD4/iD7 amplifier
firmware

As you might have noticed the version numbering of the DSPControl applica-
tion is similar to the ampilifier firmware, but not identical. This table gives an
overview on which firmware belongs to which released software version.

DSPControl software | Amplifier firmware Ethernet firmware
version version version
v3.1.9/v3.1.9.1 v3.1.9 v2.7.0

v3.6.5 v3.6.5 v2.7.0

v3.6.6 v3.6.5 v2.7.0

v3.7.0 v3.6.9 v2.7.0

v3.8.0 v3.8.1 v3.8.1

v3.9.2 v3.11.2 v3.9.0

*unpublished version




3. Troubleshooting / Known issues

Issue

> Amplifier sometimes loses network connection without apparent reason.

> Intermittent problems when accessing the ampilifier.
- Ethemet or DSP firmware cannot or just partially be uploaded.
> Intermittent problems while updating.

> The amplifier is only shown as “No Name” in the Network Panel

- Ethemet or DSP firmware update cannot be started, does not work or
falls.

> The amplifier is only shown as “Startup...” in the Network Panel.

Possible solution/reason

Please check that only one instance of the DSPControl application is run-
ning on the network. More than one DSPControl application running in the
network will cause unpredicable behaviour.

IP address conflict.

> Check if the amplifier or your network card is set to a static (fixed) IP
address. If yes, please set both to automatic (DHCP) configuration and
try again.

Network configuration error or more than one network card active.

- Try to deactivate all network devices within your computer which are not
used to connect to the ampilifier. Usually wireless network devices (includ-
ing Bluetooth devices) may cause connection problems.

> Try to connect a standard (for example 5 or 8-port) network hub / switch
between the computer and the amplifier. Some business network
switches and cards are known to sense 10 Mbit connections very slowly
or deny delivering UDP broadcasts.

> Deactivate all VPN related network connections.

- Check if the amplifier or your network card is set to a static (fixed) IP
address. If yes, please set both to automatic (DHCP) configuration and
try again.

The amplifier's Ethernet firmware is damaged and the amplifier is in boot-

loader mode.

> Use the “Network Panel” update routine (update option @ on page 7)
to repair the amplifier's Ethemet firmware.

All previous amplifier settings and Presets should be accessible again
after the ethemet fimmware update. You can start a DSP firmware update
from the “Main Control Panel” (including configuration backup) after having
repaired the Ethemet interface.



Issue
> The amplifier is only shown as “No Name” in the Network Panel AND the
amplifier is not booting anymore (the display backlight remains off and the
display just shows a row of squares).

-> Amplifier remains in Mute mode after DSP firmware update

> Amplifier not listed anymore within the DSPControl Network Panel after
firmware update (not even as “Startup...” or “No Name”)

> The network connection LEDs on the amplifiers rear panel are not blinking
on powerup.

3.1 How to power cycle your amplifier

Possible solution/reason

The amplifier's DSP firmware is damaged.

> Please power cycle the amplifier and then use the “Network Panel”
update routine (update option @ on page 7) to repair the amplifier's
DSP firmware.
All amplifier settings and Presets will be lost after this update. But possibly
there exists an an automatic or manual backup of your previous settings.
Please refer to chapter "Amplifier backup folder structure” for recovery options.

Power cycle the amplifier.

The amplifier's Ethemet firmware is not responding.

> Take the amplifier from the mains for minimum 4 minutes and restart the
amplifier again.

Power cycling means switching the unit off via the power switch on
the front panel and then wait until the display backlight switches off.
On the iD4 amplifier this takes less than 1 second, on the iD7 amplifier this
takes approx. 15 seconds. Then switch the amplifier back on again.




4. The GUI elements
Unit group edit/delete
4.1 The network panel Group name and open/ close buttons

Locate button Unit name (editable) N ) addr Unit IP address Open main control panel

Standby button

1y  Group: Examplph ge 1 |:1 umt».'l
A7 - f!‘,l CAMCOID4 B8:96:74:00:16:36 192.168.10.211

ALL UNITS
o) ()

o) < (1) CAMCOI £:96:74:00:16:36  192.168.10211 A 7™

S — CAMCO

List with all connected units VU level meter Unit firmware
(left bar: in / right bar: out) update button

4.1.1 Caption of the icons states

Sound is not muted Display in normal state Unit is offline Open panel disabled Update not available
(because unit is offing)
Sound is muted Display is blinking Unit is off Open panel enabled Update available
Unit is on Open panel locked
(panel already open)

Unit is starting up



4.2 The Main control panel

Link buttons
Main navigation buttons fader for Input 1/2,
and Output 1/2

DEFAULT PRESET

I

rrent access level indicator Input selection dropdown lists Numerics

Input 1 to 4 and Output 1 and

Amplifier name (editable)

Network link status
with amplifier selection dropdown list



4.3 The Input 1 to 4 control panels

PEQ-Filter type selection
Graphical realtime settings screen

Main navigation buttons with full window and full screen mode

Currently Loaded Preset
DEFAULT PRESET

Amplifier Presets

{ Save to Fle | tosd rom il

CAMCO iD4 (BS:

Ampiifier Name
CAMCE

Compressor button

Input channel fader

Mute button (also and numerical gain input
accessible from (also accessible from
the Main panel) the Main panel)

l

PEQ numerical gain inputs LPF On/Off-switches

with filter type selection
PEQ Q/BW-switch

and numerical inputs

PEQ numerical inputs
for frequency

Input channel
limiter control

Input delay cc

On/Off-switches for each PEQ



4.4 The Crossover control panel

e (0] O a ]
and O
e se o 9 0
a e [®) o acce e
a LJ
Ovel
Currently Loaded Preset Quty
DEFAULT PRESET
Amplifier Presets
0

[ _seve W loac |

Lood fram Fle

Link = AEEETe
CAMCO iD4 (B8:96:74:00: ~ D )

Amplifier Hame
CAMCO iD4
30 Hz 50 Hz

But18dB v |But24dB ~

75 Hz off

LR24dB v [L-R24dB -

-3.50 dB -8,00 dB

Dela 5,391 ms 0.6ms

a merical delay inputs Phase inve

LPF and HPF numerical inputs




4.5 The Output 1 and 2 control panels

Graphical realtime
settings screen with
full window

and full screen mode

PEQ Filter type selection

Input channel mixer/
routing sectio

Main navigation buttons with numerical inputs

DEFAULT PRESET

Amplifier Presets

{ Save to Fle | toad from i |

CAMCO iD4 (BS:

Amplifier e
CAMC

Mute button (also
accessilble from
the Main panel)

Phase invert buttons (also
accessible from the X-Over panel)

Compressor button
Output fader and numerical

input (also accessible from
the Main panel)

30Hz || Butterworgh 18dB % D

Linkwitz-Riley 2408

l

PEQ numerical gain inputs

with filter type selection
PEQ Q/BW-Switch

and numerical gain inputs

Qutput channel
limiter control

utput delay control

On/Off-switches for each PEQ



4.6 The Compressor control panels
Output 1 and 2

compressor navigation

BLC* filter type selection Back to Output
for compressor band 1 to 6 panel button

Bandl Band2 Band3 Band4 Band5 Band6 Channel

;

Threshold Threshold

Threshold

Qutput compressor level
and gain reduction meter

Compressor controls BLC compressor controls Compressor contr

for threshold, attack, hold, for frequency, Q, threshold, for threshold, attack, hold,
release, ratio and makeup gain attack, release and ratio release, ratio and makeup gain
with numerical inputs with numerical inputs with numerical inputs

* BLC = Bandwidth Limited Compressor




5. The menu structure

5.1 The network panel menu bar

File | Tools Help Ej X

Ay = (1) CAMCOID4

B8:96:74:00:16:36  192.168.10.167 i)

CAMCO

5.1.1 “File”-menu

> Quit
Closes the application including all amplifier panel windows.

File | Tools | Help

Set Software Password

New Group

B8:96:74:00:16:36  192.168.10.167 | s

CAMCO

Enter Demo Mode

Enable Update

Firmware Update All Units

5.1.2 “Tools”-menu

> Set Software Password

Set a password to prevent unauthorized execution of the DSPControl software.
To reset the software password just overwrite the old by leaving the input blank.

> New Group
Adds a new amplifier group.

> Enter Demo Mode
This menu item enables a virtual iD4 and iD7 demo-amplifier.

> Enable Update
Activates visibility of the firmware update button for the connected ampilifiers.

> Firmware Update All Units
This will update all conneted amplifiers to the newest version in case they are
still running an older firmware version.

File Tools | Help Ej X

ALL UNITS m "
b th Units (1 units online)

Ay = (1) CAMCOID4 B8:96:74:00:16:36  192.168.10.167 |

CAMCO

5.1.3 “Help”-menu
> About:

Shows the application information window with the application version and
pbuild number.

= User mode BT = Administrator mode IEE = Developer mode



5.2 The amplifier panel menu bar

Eile | Unit _Help Eile | Unit  Preset  Help
Load Preset from File Load Preset from File

Save Preset to File Save Preset to File

Load Factory File Create Flash Image
Load Flash Image Load Flash Image
Restore Presets from Folder Restore Presets from Folder

Backup all Presets to Folder Backup all Presets to Folder

Quit cul+Q Quit cul+Q

5.2.1 “File”-menu

> Load Preset from File
Load a Preset from your computer into the amplifier.

> Save Preset to File
Save the currently loaded Preset from the ampilifier to your compuiter.

> Load Factory File XX / Create Flash Image IEE

Load a Factory File from your computer into the ampilifier in User or Administra-
tor mode or create a flash image with the current configuartion of the amplifier
and save it to your computer in Developer mode.

> Load Flash Image
Load a flash image from your computer into the amplifier.

> Restore Presets from Folder
Load a backup-folder with multiple Presets at once into the amplifiers memory.

> Backup all Presets to Folder
Save a backup of all Presets from the amplifiers memory to your computer.

> Quit
Close the amplifier panel window.

Eile | Unit | Preset  Help

Change Access Level
Passwords

Access Rights
Configure

Lock Unit

Exit Standby

Firmware Update

Status Details

5.2.2 “Unit”-menu

Please note that not all menu entries might be available depending on the
current access level and access right settings.

> Change Access Level
Change the access level of the Amplifier to User, administrator or Developer
mode by using the appropriate passwords.

> Passwords

Change the default Unit password of the current access level.

In Developer mode it's possible to change the default Unit passwords of all
three access levels directly.

> Access Rights
Configure the Unit access rights for all lower access levels.

> Network Settings (Configure )
Configure the network IP settings from automatic (DHCP) to manual.

= Usermode BT = Administrator mode IEETM = Developer mode




Telnet Interface (Configure ) IEEM
Activate/deactivate the Telnet remote access feature.

Power on Preset (Configure )
Choose the Preset which will be loaded automatically on startup of the amplifier.

Read-Only Preset Range (Configure -) IEE
Set the range of Presets which are read-only in User and Administrator access
level.

Auto Standby (Configure )
Set the delay time after which the amplifier will go to standby automatically if
no signal is present.

Output Mode (Configure )
Set the ampilifier stage output mode to “Stereo” or “Bridge Mono”.

Display (Configure )
Change the state of the display-backlight between "On”, “Delayed Off" or
“‘Dimmed”.

Lock Unit
The Unit will be set to the locked-state and can only be unlocked with a correct
access level password.

Go to Standby / Exit Standby
Enters or exits standby mode.

Firmware Update
Performs a firmware update of the Unit. Updating the firmware will always reset
all settings (i.e. access rights, passwords, Unit name, network settings, power-
on Preset, read-only Preset range, auto-standby and display setting) to factory
defaults and all Presets will be erased.

fo avoid losing your settings and Presets you can either do a manual backup
before the update or use the automatic backup and restore function offered
during the update procedure.

Updating the firmware also can be used to reset the iD4/iD7 amplifier to a
blank state with default passwords and access rights.

Status Details
Opens a window with the current amplifier temperature, the load impedance
and possible faults.
Please note that the impedance measurement might indicate 3,0 Q in case
no or only very small output signal is present (especially if no loudspeakers are
attached). The impedance measurement is designed to work very accurately at
mid to high output levels and with actual loudspeakers attached.

= User mode BT = Administrator mode IEE = Developer mode



File  Unit | Preset | Help

Passwords L

Access Rights »

Clear All User Presets

Currently lﬂ Clear All Factory Presets
DEFAbLCT PRESET —

5.2.3 “Preset”-menu IEEH

> Admin Password

Change the Administrator password of the currently loaded Preset. If set, this
Preset password will override the default Unit Administrator password as long
as this Preset is active/loaded.

> Developer Password

Change the Developer password of the currently loaded Preset. If set, this
Preset password will override the default Unit Developer password as long as
this Preset is active/loaded.

A Important
If set, Preset passwords always have a higher priority then the Unit pass-
words! For details see chapter “Managing the access rights and passwords”.

> User Access Rights
Set the User access rights for input- and output channel.

> Admin Access Rights
Set the Administrator access rights for input- and output channel.

> Clear All User Presets
Deletes all Presets from the amplifiers memory that are not set as ready-only
Presets.

> Clear All Factory Presets
Deletes all Presets from the amplifiers memory that are set as read-only Presets
(Factory Presets).

File Unit Preset | Help

Currently Loaded Preset
DEFAULT PRESET

5.2.4 “Help”-menu

> About
Shows unit and application information (name, serial number, IP address, MAC
address, firmware version, interface version, application version and build
number).




6. Managing your Presets with the DSPControl software

6.1 “Save” — Save all Preset-related stuff inside the amplifier

The Preset is then stored to the Preset location currently selected in the Preset
list, with the name typed in the “Currently Loaded Preset’-field in the upper left
corner. Any previous Preset stored at this location will be lost when overwriting
it with a new Preset.

6.2 “Load” — Load a Preset from the amplifier’s Preset list
Loads the selected Preset into the amplifier. Any unsaved changes to the previ-
ous Preset will be lost.

6.3 “Save to File” — Save all Preset-related settings to your computer
Pressing this button does not automatically store the Preset inside the amplifier.
So if you want to store any changes both on your hard drive and inside the
amplifier don't forget to press the “Save” button as well.

6.4 “Load from File” — Load a single Preset from your computer into the
amplifier

Pressing this button will not automatically store the Preset inside the amplifier.
So if you want to store the freshly loaded Preset permanently inside the ampli-
fier don't forget to choose a location from the amplifier's Preset list and to press
the “Save” button.

6.5 “Backup all Presets to Folder” (> “File”-menu)

Creates a backup of all Presets stored inside the amplifier to a folder on your
computer's hard drive. This procedure can take some time depending on the
amount of Presets to be backuped. Only the Preset-related settings will be
stored, not the Unit level settings. See the chapter “Preset Settings” for detalls.

6.6 “Restore all Presets from Folder” (> “File”-menu)

Restores a previously created backup from a folder on your computer's hard
drive. This procedure can take some time depending on the amount of Presets
to be restored. Only the Preset-related settings will be restored, not the Unit
level settings.

In case you want backup or restore a whole set of Presets we recommend
to use the “Save Flash Image” and “Load Flash Image” options instead,
because they work much faster.

For this you could prepare one dedicated binary backup with all Presets
you need, and then simply upload it to another amplifier.

The only drawback is that all amplifier settings (including all passwords
and access rights) will be overwritten with the values stored in the binary
flash image backup. This might not be adequate for some application
scenarios.

6.7 “Load Factory File” (> “File”-menu)

Loads an old Factory File into your amplifier. Loading a Factory File will auto-
matically change all access rights, passwords and settings to the values stored
inside the Factory File.

But be aware that a certain combination of deactivated Unit access rights can
effectively lock you out of the unit permanently if you don’t know the new pass-
words! So please make sure to only load Factory Files from trusted sources,
which either:

- will allow at least a firmware update in User mode (which gives you the
option to effectively reset the iD4/iD7 amplifier to a blank state with all
access rights granted) or ...

- will have their specific Administrator and Developer passwords published.

The best way to load a Factory File would be to carry out a firmware update
first, in order to erase all old Presets. Otherwise all Presets stored to locations
not included in the new Factory File will not be deleted.

Note that creating Factory Files is not longer supported since version v3.9.2.
This feature has been replaced by the “Save Flash Image” and “Load Flash
Image” options.



6.8 “Load Flash Image” (> “File”-menu)

This will update the amplifier to the selected backup file which includes all
amplifier settings, Presets, passwords, access rights and firmware version.

Please be careful to only load flash images from trusted or known sources. It's
because you could possibly be locked out of the unit in case you don't know
the Unit or Preset passwords inside the binary backup!

The ampilifier will be switched into standby mode during the binary upload pro-
gress.

6.9 “Save Flash Image” (> “File”-menu, in Developer mode only)

Creates a complete backup of all amplifier settings into a single file. This
includes all amplifier settings, Presets, passwords, access rights and the firm-
ware version.

The flash image backup should be used if you want to create an image (clone)
of all amplifier settings. This gives you the option to easily set up your rolling
stock of amplifier's to a defined state, without having to worry about configuring
each amplifier individually.

Please do not use the flash image option if you only want to publish a set
of Presets to your customers. This should be done with the load/save or
backup/restore functions for individual Presets.

It is possible to lock some or all of those load, save, backup and restore
options in User and Administrator mode through the Unit Access Rights.
For details see the chapter “Unit Settings” below.




7. Managing the access rights and passwords

In order to understand how the access rights are managed in the iD4/iD7
amplifier, it is important to know that all passwords and access right settings are
always stored and checked inside the amplifier.

This means that everytime you will for example switch to Developer mode in the
software, the password is transferred to the amplifier and validated there. If the
password is correct, the amplifier (and in turn also the DSPControl software) will
switch to Developer mode, thus giving full access to all functions and settings.
If the password was wrong, the amplifier will deny Developer access and the
software will show the message “Invalid Password”.

Example 1
If you are not allowed to access the output settings of the currently loaded
Preset, it will not be possible to change any output settings on the amplifier's
display either.
Once entered the correct password in the DSPControl software, both the
amplifier's display and the software will allow full access to the output settings.

Example 2
If you enter Developer mode from the amplifier's display (through " » "-MENU >
Access Level), the DSPControl software (if connected) will also automatically
switch to Developer mode.

Secondly it is important to know that the Administrator and Developer pass-
word can be different for each Preset individually.

This means for example that if you load a Preset which has custom Admin and/
or Developer passwords you will need those passwords to access Admin or
Developer mode. The default password stored at Unit level will not work any-
more as long as this Preset is loaded and active.

By loading any another Preset without custom passwords (an empty Preset for
example) you will again be able to access Admin or Developer Level with your
well-known default Unit level passwords.



8. The access rights hierarchy

o%E

DEVELOPER MODE

IEE The Developer mode always gives access to all functions of the iD4/iD7
amplifier. Especially setting individual Preset access rights and passwords can
only be done in Developer mode. The Developer always has the right to change
all access rights and passwords for the lower access levels (Admin, User and
Locked).

CamcoDev

e restricted)

2

ADMINISTRATOR MODE

B The Administrator mode (abbreviation ‘Admin’) gives the option to allow a
configurable intermediate access level which has less rights that the Developer
level but more than the User level. It's up to the system Developer to decide
which access rights are granted to system Administrators.

Setting Admin access rights can only be done in the higher Developer mode,
changing the default Admin password can be done directly in Admin mode
(and in Developer mode of course).

The Administrator is normally allowed to change all access rights and pass-
words for the lower access levels (User and Locked).

ord is: CamcoAdm
are: all active

i 11

USER MODE
This is the default access level when powering up the iD4/iD7 ampli-
fiers. So the amplifier will typically be operated in User mode. Setting the User
access rights can only be done in the higher Admin or Developer mode, chang-
ing the default User password can be done directly in User mode (and in the
higher Admin or Developer levels of course).

The User can be allowed to change all access rights for the lower Locked level,
provided the User himself has been granted the specific access right.

Example
If the User has not the right to change the amplifier name, he cannot in tum
give the right to change the amplifier name in the locked state. The option will
then not be available.

s: User
are: all active

a

LOCKED MODE

This mode is typically used to prevent any intentional or unintentional
changes both inside the DSPControl software and the amplifier's display, when
for example leaving the DSPControl computer unsupervised.

Once entered, a password for any higher access level (User, Admin or Devel-
oper) is needed to exit the locked mode.

The def

It is basically possible to restrict the Administrator and User access rights
to /ess than the lower Locked access mode. But then the lower access
level would have more rights then the higher level, which might be con-
fusing. This is up to the Developer or Administrator to decide.

ult re: all inactive (loc




9. Unit and Preset level access right options

Developer Admin mode User mode Locked mode
mode

Load Presets always allowed configurable in configurable in configurable in
Select if it's allowed to load any Presets from the amplifier's | DEV | | DEV_Fq ADM | | DEV N ADM K}
Preset list or from your computer's hard drive
Save Presets always allowed configurable in configurable in configurable in
Select if it's allowed to save any Presets inside the amplifier or [ DEV | | DEV_Fq ADM | [ DEV N ADM JY
to your computer’s hard drive
Enable Display Lock Control always allowed configurable in configurable in not available
Select if it's allowed to lock the Unit from the amplifier's display [ DEV | | DEV_Fq ADM |
Change User Access Rights available not available not available not available

3 Select if it's allowed to change the User access rights in Admin mode

£ Change Locked Access Rights always allowed configurable in configurable in not available

E Select if it's allowed to change the Locked access rights in [ DEV | | DEV Y ADM |

7 Admin or User mode
Change Unit Name always allowed configurable in configurable in configurable in
Select if it's allowed to change the amplifier's name [ DEV | | DEV Y ADM | [ DEV | ADM A
Change Unit Configuration always allowed configurable in configurable in configurable in
Select if it's allowed to change the network settings, the auto- [ DEV | | DEV_Fq ADM | | DEV N ADM Y
standby time and the power-on Preset
Load an Empty Preset always allowed configurable in configurable in configurable in
Select if it's allowed to load an empty Preset from the amplifier [ DEV | [ DEV_Fq ADM | | DEV_ i ADM KX
Update the Unit firmware* always allowed configurable in configurable in configurable in
Select if it's allowed to update the Unit firmware | DEV | CED & | DEV N ADM Y
Access Input channel (panels) always allowed configurable in configurable in always locked

| DEV |
Acess X-Over and Output channels (panels) always allowed configurable in configurable in always locked
| DEV | [ DEV | | & ]

* Updating the firmware also can be used to reset the iD4/iD7 amplifier to a blank state with default passwords and access rights. Also all Presets will be erased after firmware update.

= User mode IECI = Administrator mode IEEM = Developer mode = Locked moce EEMR = Always locked




10. The settings which are stored at Unit level

Meaning that those are always the same no matter which Preset currently is
loaded, with one exception for the passwords, please see below.
Changes to any of these settings will be stored immediately inside the amplifier.

Default User, Administrator and Developer Passwords

Password override possible inside each Preset if programmed!

Locked, User and Administrator Access Rights
Please see dedicated access rights table at chapter “The access rights hier-
archy’.

Unit Name
Just type the desired name inside the text box on the left side of the amplifier
panel or change it directly in the Network Panel (provided you have the right
to change 1t).

Network Settings
Either select automatic IP adress configuration through your DHCP server or
select a fixed IP address and subnet mask.

Telnet Interface IEEM
You can also activate or deactivate the Telnet remote access to the amplifier.

Power On Preset
Select which Preset shall be loaded automatically after powering up the
iD4/iD7 amplifier.

Read-Only Preset Range IEEM
Set a range of Presets which cannot be overwritten in Admin, User or Locked
mode. Saving to those Preset locations will not be possible.

Auto-Standby
Set the time after which the amplifier will go to Standby mode if no analoge and
digital input signal was fed to the amplifier.
If the amplifier has been set into standby through the auto-standby function,
automatic wakeup will only work if digital AES input signal is applied again.
Applying analogue signal again will not wakeup the amplifier.
When unsing analogue input signal, exiting the automatic standby mode must
be done manually through the ampilifier's display or the DSPControl applica-
tion. So please consider this carefully before using this function with analogue
input signal.

Display
Set the amplifier's display backlight status:
> 0On
> Delayed Off
- Dimmed

= User mode IEEIID = Administrator mode IEEM = Developer mode




11. The settings which are stored inside each Preset individually

Meaning that those settings might change when another Preset is loaded.

Changes to any of these settings are not automatically stored inside the
currently loaded Preset. So please don’t forget to save all changes inside
the amplifier by clicking on the “Save” button. If you don’t save, all set-
tings and changes will be lost if you switch the unit off or if you load
another Preset.

Custom Administrator and Developer passwords IEEH
> Blank/empty = Unit default:
The Admin or Developer level can be accessed through the default Unit
passwords.
> Any custom password:
If this Preset is loaded, then the Admin or Developer level can only be
accessed with this custom password.

User and Administrator Access Rights for accessing the Input or
X-Over/Output panels IEEW
Please see dedicated access rights table at chapter “Access Right Options”.

Amplifier Output Mode (Stereo or Mono Bridged)
Accessible through the menu “Unit » Configure - Output Mode > ..."

And of course all audio settings configurable in the Main, Input,
X-Over and Output panels
(e.g. input selection, volume, mute, EQ, delay, crossover, limiter settings and
many more)

= User mode = Administrator mode = Developer mode
U je BT = Administrator mode IEEM = Devel e



12. Remote Access (Telnet)

Each Unit (with firmware v3.8.0 and higher) offers the option the access basic
functions of the amplifier through a simple Telnet connection protocol, without
the need of using the DSPControl application. With this feature the amplifier
can be easily controlled over a 3rd party media control device, or even your
smartphone for instance.

12.1 It offers following features
> Setting the Gain of each Input and Output channel
> Setting the Mute of each Input and Output channel
> Loading a Preset
> Setting the ampilifier to standby
> Locating the amplifier (display blinking) to identify it in a larger system

The Telnet remote access works with the same access rights management
than the DSPControl application.

This means that setting the gain and loading a Preset might be blocked if the
amplifier's access rights have been restricted by the developer.

If those commands are sent over Telnet to a locked amplifier they will simply be
ignored and nothing will happen.

Also please note that the graphical response of the DSPControl application
to Telnet commands (if opened at the same time) might be extremely slow.
Although the command is executed immediately inside the amplifier's DSP,
it might take several seconds for the DSPControl application to display the
changes.

By default, Telnet is not installed/activated with Windows, but you can
easily install it by a few simple steps. See chapter “How to install/activate
Telnet with Windows” on page 32.

12.2 Protocol definition
For accessing the amplifier it is first of all needed to know it's the IP address.
The access is initiated by following command (without quotation marks):

“telnet XXX XXX XXX XXX 28"

It is important to add the “23" at the end for proper communication.
After a few seconds, the amplifier will respond with a welcome message and is
then ready for receiving commands.

12.3 The available commands
‘g" Set Gain (followed by channel index and gain value)

‘m[x]": Mute/Unmute channel (followed by channel index) with [x] defined as:
'0'=Unmute, ‘1'=Mute
Default [x] value if not specified/omitted: ‘0’

“p[x]":  Load Preset where [X] is the desired Preset number
Default [x] value if not specified/omitted: 1’

“s[x]"; Set amplifier to standby with [x] defined as:
'0'=Exit Standby, ‘1'=Go to Standby
Default [x] value if not specified/omitted: ‘0’

Locate Amplifier. Display is blinking
‘e” Execute command (to apply the settings in the amplifier)

The parameters (for Gain and Mute commands)

‘c[x]": Channel index with [x] defined as:
1'=In1, '2'=In2, '3'=In3, ‘4'=In4, "11'=0ut1, "12'=0ut2
Default [x] value if not specified/omitted: ‘11"

VX" Gain value with [x] defined gain value in 1/100 of dB
(e.9. -100' = -10B)
Default [x] value if not specified/omitted: ‘0’




“e” must always be sent at the end of the command sequence in order to
apply the changes to the amplifier.

Omitting to send the “e” at the end will simply ignore any previous commands
and nothing will happen.

12.4 Examples
For setting the gain of output channel 1 to -3 dB type:
g [Enter] > c11 [Enter] » v-300 [Enter] > e [Enter]

For muting the output channel 2 type:
m1 [Enter] > c12 [Enter] > e [Enter]

For loading Preset no. 15 type:
p15 [Enter] > e [Enter]

For setting the amplifier to standby type:
s1 [Enter] > e [Enter]

For locating the amplifier type:
| [Enter] & e [Enter]

12.5 How to install/activate Telnet with Windows

Follow the steps below to install Telnet Client:

© Go to the Programs setup page (usually to be found in the Control
Panel) and then select Turn Windows features on or off. Then you will be
prompted for administrative access rights, which have to be granted.

® In the Windows Features dialog box, select the Telnet Client check box.

© Click OK. The installation might take several minutes.

12.6 Using Telnet with OS X
You can use the built-in Terminal application found in the Utilities folder under
Applications.



13. How to backup and restore old Presets

Dueto some changesinthe Preset structure itis neccesary to follow a certain
procedure to transfer your old Presets from version v3.1.9/v3.6.5/v3.6.6
to the the latest version v3.9.2 (or higher).

Simply using the automatic backup and restore function (available when doing
a frmware update from the amplifier panel) will not work for transferring Presets
from very old firmware versions.

This feature can only be used for updates from v3.7.0 to v3.9.2 or higher
versions.

Also old Factory files created in version v3.1.9 (and lower) are not compatible
anymore and will fail to load correctly.

Please note than in case you don’t need to convert any of your old Pre-
sets you can of course skip this procedure and directly carry out an
update from v3.1.9 to v3.9.2 (by using the firmware update "Option ®: Via
the network panel’s update button for a specific amplifier” on page 7).

13.1 How to transfer old Presets to version v3.9.2 (or higher)?

© Save your Presets with the (old) version you are currently using (v3.1.9,
v3.6.5 or v3.6.6). Either one by one or by using the Backup Presets option.

@ Install the version v3.9.2 (or higher) on your computer.

© Open the software and carry out a firmware update without creating an
automatic backup of all amplifier settings.

@ Then manually load your Presets back into the ampilifier (one by one or with
the “Backup all Presets from Folder” option).

Then you can optionally (if you want to protect your Presets now*):
© Switch to Developer mode.
@ Set the new Preset level access rights (to lock/unlock input and output
access) to your needs for each Preset individually by:
> Loading the Preset in the amplifier.
> Setting the desired User and Admin access rights and Admin and
Developer custom passwords (optional).
> Saving the Preset inside the ampilifier.

* Locking Input and Output channel access is stored inside each Preset individually since
version v3.6.5, not anymore inside the Unit access rights




14. Signal Processing Block Diagram

Input DSP 1
B3 ey Input Source Selection Gain VU Meter Crossover
Analog 1 PEQ (10x) Compressor Peak Limiter Delay Mute
ADC g1 & Link
= Input DSP 2
B3 gemmy Input Source Selection Gain VU Meter Crossover
Analog 2 PEQ (10x) Compressor Peak Limiter Delay Mute
ADC 1
> Input DSP 3
B0 mmmmy INpUt Source Selection Gain VU Meter Crossover
AES PEQ (10x) Compressor Peak Limiter Delay Mute
srRc @2 & Link
> Input DSP 4
B 3 menn Input Source Selection 2138 Gain VU Meter Crossover
PEQ (10x) g Compressor g Peak Limiter g Delay Mute

—-

—a-

—0

—0-

@ = Number of signal streams

Power Loud-
Output DSP 1 Amplifier ~ speaker
Output
B4 Mixer Gain Crossover g PEQ (10x) g Compressor
Peak Limiter g VU Meter Phase Invert Delay Mute [(
& Link
Output DSP 2
R4 mes Mixer 21 Gain Crossover z PEQ (10x) g Compressor
Peak Limiter g VU Meter Phase Invert Delay Mute ﬂ—%l:g

Refers to firmware version v3.6.9



15. Unit Conversion Equations and Lookup Table 15.2 Lookup Table

15.1 Unit Conversion Equations Vaws Veea Gl el DAL | e MTUE | (L
power power power
Unit conversion Equation (inW/8Q)|(InW/4Q)|(inW/2Q)
) 1 1,41 2,22 0,00 0,13 0,25 0,50
i Value in Vs
Vi > dBU Level in dBu=20+log W) 2 283 | 824 | 602 | 050 1,00 2,00
3 4,24 11,8 9,54 1,18 2,25 4,50
Ve > OBV Level in dsv=20*|09(‘fa’:”eoc’)f(')‘gm 2 ::gi 1;2 E:g g?g ggg ?’;2
6 8,49 17,8 15,6 4,50 9,00 18,0
dBuS V. ; 'Leve/zrguau] 7 99 19,1 16,9 6,13 12,3 24.5
RS Voltage in Vs =0,7746+10" 8 11,3 20,3 18,1 8,00 16,0 32,0
9 12,7 21,3 19,1 10,1 20,3 40,6
Levelin gBv | 10 14,1 22,2 20,0 12,6 25,0 50,0
9BV Voo AL "”VWS:‘O( =) 12 170 | 238 | 216 | 180 36,0 720
15 21,2 25,7 23,5 28,1 56,3 113
Ves 2 Voo Voltage inV,,, =1,414x(Voltage in V) 20 28,3 28,2 26,0 50 100 200
30 42,4 31,8 29,5 113 225 450
) o, 40 56,6 34,3 32,0 200 400 800
. (Voltage inV,,,s ) i
Output power in W:T 50 70,7 36,2 34,0 SIS 625 1250
60 84,9 37.8 35,6 450 900 1800
: " (Vottage iV, 70 99,0 39,1 36,9 613 1225 2450
Vs > Outout power Output power in W =——— == 80 113 | 403 | 381 800 1600 | 3200
90 127 41,3 39,1 1013 2025 4050
 (Voltage inV,,,* 100 142" 42,2 40,0 1250 2500 O
Output power in W=——3—"— 117 | 1652 | 436 | 41,4 | 1711 | 3422 845

" Max. peak voltage iD4 / * Max. peak voltage iD7 /
The iD4/iD7 is not able to deliver these output powers in dual ¢ el operation
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